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Triple-Axis WaveCatcher Components 
 

♦ Carrying Case 

♦ Analog-to-digital conversion module (A/D module) 

♦ Netbook Computer 

♦ PCB Piezotronics Testing Microphone 

♦ USB Type B-to-USB Type A cable 

♦ Computer power cable 

♦ Three BNC-to-BNC cables 

♦ Manuals and Certifications 

♦ Separate Case: VA-2 Vibration Analyzer 

♦  VA-2 Control Box 
♦  VA-2 Sensor Head with Cable 
♦  Power Cable 
♦  VA-2 Manual 

 
Netbook Computer A/D Module Microphone Option 

Cables Space for Component Expansion 
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Setting Up 
 

1. Remove netbook computer and computer power cable from WaveCatcher case.  

2. Connect power cable to netbook computer.  Plug in to wall outlet.  Open computer and 
turn on by pressing Power button. 

3. Connect the A/D module’s USB Type B output to the computer’s USB Type A input 
using the USB cable.  

4. Launch the WaveCatcher software using the icon on the desktop or via the icon on the 
start menu. 

Running a Vibration Test 
 

5. Remove netbook computer and computer power cable from WaveCatcher case.  

6. Connect power cable to netbook.  Plug in to wall outlet.  Open netbook and turn on by 
pressing Power button. 

7. Use the USB cableConnect the WaveCatcher A-D conversion unit to the computer via 
USB cable to the computer’s USB port.   

8. Set up the VA-2.  Remove sensor head, control box, BNC cables, and power cord from 
case.    Connect the sensor head to the control box.  Connect the power cord to the control 
box and plug in.  Connect control box outputs to A-D conversion unit inputs.  The 
recommended configuration is to connect the V output to Input 1, H1 output to Input 2, 
and H2 output to Input 3.  Turn the VA-2 ON by pressing the Power button. 

9. Check the adjustment dials on the VA-2.  The Output dial should be set to ‘V’.  The 
default Gain setting is ‘2’.  Check the Function dial to ensure it is set to the appropriate 
units, the default Function setting is VEL (velocity).  If the Gain or Function settings are 
changed, the input settings will need to be changed in the WaveCatcher (details below). 

10. Start the WaveCatcher Program via the Start menu or the shortcut on the desktop. 

11. Load a Quick Set for easy configuration of the test.  Go to Quick Set menu, open your 
location’s Site Survey folder.  Select ‘(your location) – Func- VEL, Gain- 2.wqs’, press 
Open.  If a function is needed, load it and adjust the VA-2 function setting accordingly. 

12. Adjust the settings and display functions as desired in the Run Control pane (see below 
for additional details).  Add relevant testing details in the text field.  Set the desired 
number of averages to take in your test.  We recommend taking at least ten averages for a 
site survey. 

13. Press Start to run a test. 

14. You will see the averages counting up in the Averages box.  You can stop the test before 
it completes the specified number of Averages by pressing Cancel.  The test data will not 
be automatically saved if you press Cancel, but you can save the data manually using the 
instructions below. 
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15. The test will automatically stop upon taking the specified number of averages.  The data 
will automatically be saved to a .CSV file.  A dialog box will appear showing the file 
name that the data was saved to. The automated name is also a date stamp. Press OK to 
continue.  See Saving and Using the Data section for other Save options. 

16. Repeat steps 8 - 11 to conduct additional tests. 

 

Running an Acoustic Test 
 

1. Connect power cable to netbook computer.  Plug in to wall outlet.  Open netbook and 
turn on by pressing Power button. 

2. Connect the WaveCatcher A-D conversion unit to the computer via USB cable to the 
computer’s Front Right USB port.   

3. Connect the acoustic microphone to the Input 1 BNC connector on the A-D conversion 
unit.  Be careful not to touch the tip of the microphone. 

4. Start the WaveCatcher Program via the Start menu or the shortcut on the desktop. 

5. Load a Quick Set for easy configuration of the test.  Go to Quick Set menu, open your 
location’s folder.  Select ‘(Your Location) – PCB Microphone.wqs’, press Open.   

6. Adjust the settings and display functions as desired in the Run Control pane (see below 
for additional details).  Add relevant testing details in the text field.  Set the desired 
number of averages to take in your test.  We recommend taking at least ten averages for a 
site survey. 

7. Pres Start to run a test. 

8.  You will see the averages counting up in the Averages box.  You can stop the test before 
it completes the specified number of Averages by pressing Cancel.  The test data will not 
be automatically saved if you press Cancel, but you can save the data manually using the 
instructions below. 

9. The test will automatically stop upon taking the specified number of averages.  The data 
will automatically be saved to a .CSV file.  A dialog box will appear showing the file 
name where that the data was saved.  Press OK to continue.  See next section for other 
Save options. 

10. Repeat steps 7 - 9 to conduct additional tests. 
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Saving and Using the Data 
There are three methods to save test data: 
 
Auto Save:  Upon completing a test, a .CSV file with the data will automatically be saved to the 
WaveCatcher folder in My Documents, created upon installation.  You may access this data 
using File Explorer to open it in Excel or other software. 

Save Bitmap:  This will save a bitmap (.BMP) image of the graph as it is currently configured, 
including input labels.  Access the File menu and select Save Bitmap.  Choose the destination 
folder and the file name to be saved. 

Save Data: This will save a comma-seperated values (.CSV) file of the data which you have 
taken in the current test.  Access the File menu and select Save Data.  Choose the destination 
folder and the file name to be saved. 

Copy:  This will copy a bitmap image of the current test to your computer’s clipboard.  Access 
the Edit menu and select Copy.  Access the document (for example, a Word file) to which you 
would like to insert the image, access the Edit menu, and select Paste. 

 
Run Control 
 
Start Button:  Starts the test.  Click on this button to start taking data. 
 
Cancel Button:  Cancels the test currently running.  If the test is cancelled, data will not be 
automatically recorded for that test.  You may save the data set manually. 
 
Units:  Determines in what units the data will be displayed and recorded.   
 V – volts 
 g – g’s represent acceleration divided by Earth’s gravitational pull 
 m/s^2 – meters per second squared 
 Pa – Pascal, SI derived unit of pressure 
 SPL – sound pressure level, measure of sound pressure 
 
Start Frequency:  Determines the minimum frequency for which data will be recorded.  The 
absolute minimum frequency is 1 Hz. 
 
Stop Frequency:  Determines the maximum frequency which data will be recorded.  The 
absolute maximum frequency is 5000 Hz. 
 
 NOTE: Your sensor may have frequency limitations within these minimum and 
 maximum values.  Data recorded beyond these limitations will not be accurate. 
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Averages:  Determines the number of samples that will be taken in the test.  The data will be 
averaged across the number of samples.  It is recommended to take AT LEAST 10 averages per 
test. 
 
Window:  Allows you to choose the type of FFT filter applied to the data.  You can choose 
between Rectangular and Hanning.  Hanning is more common for use in site surveys. 
 
Run Notes:  Enter notes on each test here.  The notes will be saved with the test data.  
Information regarding the test should be recorded here, for example date and time, location, and 
units. 
 
 
Input Settings 
You can manipulate several display and recording settings for each Input.  Toggle between the 
three inputs by clicking the tabs at the top of the Input settings pane.  NOTE: Changing a setting 
for one Input will not automatically change the setting for the other inputs. 
  
Check Boxes: 
Show:  Check to have the given input appear on the display graph as a trace and have the input’s 
data recorded.  Unchecking the box will remove the input’s trace from the display graph and will 
remove the input’s data from the data set. 
 
Cursor:  Adds or removes a cursor from the input’s trace in the display graph.  The cursor can 
be moved to pinpoint certain data points on the input’s trace.  The Cursor can be moved by 
clicking and holding on the cursor’s dashed line with the mouse and moving it to a new position. 
 
ICP:  Check this box if you are taking data using an ICP sensor.  Leave this box unchecked if 
the sensor is non-ICP (ie. it has its own power source). 
 
Sensitivity (V/EU):  Enter the sensitivity of your sensor here to record accurate data.  A sensor’s 
sensitivity can be found in the sensor’s documentation.  Be sure to use V/EU units.  Check that 
you have the accurate units and, if not, perform conversion prior to entering the value.  The 
sensitivity value will be recorded with the data. 
 
Label:  Enter a Label for the Input’s trace on the Display Graph.  This label will be recorded 
with the data.  It is recommended to use the label to indicate the sensor being used, the axis being 
measured (if applicable), and the units selected. 
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Using QuickSet 
A QuickSet function is included to allow you to save your Run Control and Input settings and 
load these settings later.  This will preserve your preferred testing configuration from day to day 
and will save the time and trouble of repeatedly entering your settings. 
 
To Save a QuickSet:  Once you have entered your preferred settings in the Run Control and 
Input sections, access the Quick Set menu and select Save Settings.  Select the preferred save 
location (the default location is the WaveCatcher folder) and enter the name of the QuickSet 
settings.  Choose a name which is relevant to the type of test that the settings will be used for in 
the future, for example “Site Survey – Indoors”. 
 
To Load a QuickSet:  Access the Quick Set menu and select Load Settings.   Locate the desired 
QuickSet file, select it, and click Open.  This will automatically configure your settings and you 
will be prepared to start taking a test. 
 
Display Settings 
You can manipulate the display graph using the controls above the graph.  The same controls are 
provided for both the Horizontal and Vertical Axes. 
 
SCALE:  
Horizontal Axis:  Allows you to toggle between Linear and Log Scale. 
Vertical Scale:  Allows you to select linear magnitude (LinMag), logarithmic magnitude 
(LogMag), or decibel magnitude (dBMag). 
 
Autoscale: Checking this box automatically sizes the axis to fit the data that is taken. 
 
Min:  Allows you to manually set the minimum value displayed for that axis. 
 
Max:  Allows you to manually set the maximum value displayed for that axis. 
 
 NOTE:  You will need to uncheck the Autoscale box to manipulate Min and Max 
 settings. 

 

Feedback 

Herzan welcomes your feedback!  Please let us know what we can do to improve our 
products.  You can reach us at feedback@herzan.com or (949) 363-2905.  We look forward 
to hearing from you! 
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Appendix A: 
Conducting a Site Survey – Best Practices 

 
♦ Ensure that you are not changing parameters between tests which you plan to compare.  

♦ The more averages that are taken, the more noise will be filtered out.  Taking more 
averages will ensure more accurate data. 

♦ For vibration testing, make sure the sensor is firmly coupled to the surface you would like 
to measure.  For light accelerometer heads, adhesive or wax may be required to ensure a 
firm coupling. 

♦ Beware of 60 Hz spikes in the data.  These are often related to electro-magnetic 
interference and can be an artifact.  If you notice significant 60 Hz spikes in your data, 
make sure your testing set-up is grounded properly and run the test again. 

♦ Narrow the frequency span of your test to achieve better frequency resolution.  If you are 
unsure of the frequency area of interest, start with a broad frequency range and narrow 
your focus based on results. 

♦ Significant resonances in one axis can often feed into other axes and appear in the data 
for other directions.  Measure multiple points in different locations to diagnose the 
phenomenon. 

♦ Noise levels change throughout the day, due to foot and street traffic, equipment running, 
and other causes.  It is recommended to run tests at different times of day to filter out the 
periodic noise. 

♦ When doing comparative measurements, eliminate as many variables as possible.  If 
possible, take the data simultaneously using identical sensors, with the sensors aligned. 
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Appendix B: 
VA-2 Sensitivity Unit Conversions 

The VA-2 takes data in EU/V and the WaveCatcher software uses a V/EU sensitivity setting.  So 
the Sensitivity setting will need to be adjusted depending on the Function and Gain setting used 
on the VA-2 controller.  Please use the below table to find the correct Sensitivity (V/EU) setting 
to enter in the Input pane. 

 
 

GAIN: 
UNITS: 1 2 3 

Acceleration (m/s2) 1 10 100 

Acceleration (g’s) 9.81 98.1 981 

Velocity (m/s) 100 1000 10,000 

Displacement (m) 1 x 10^4 1 x 10^5 1 x 10^6 

 
 

 NOTE: If you are taking data in all three axes, be sure the Output dial on the VA-2 
 controller is set to ‘V’ and that the Show box is checked for all three inputs in the Input 
 pane. 

 


